
 

How to Build and Update a PIE File? 

 

To update a PIE file, go directly to section 4.2.4. 
 

4.1 Critical PIE take away 

 Five main inputs are needed: 

 

- Test type indicating the dominant reservoir fluid (with the use of pseudo-

pressure or pseudo-pressure with material balance correction when the 

dominant phase in the reservoir is gas), 

- Static data from the open log (net reservoir thickness, rock compressibility, 

Swi…) 

- PVT data (formation volume factor, fluid compressibility…) 

- Rate data since start-up (measured and allocated) 

- Gauge Pressure data, with for example a 1h interval during flowing 

conditions and <30-second interval during PBU tests (<5s for high 

permeability gas reservoirs and <15s for high permeability oil reservoirs). 

 

Once these data are added, the following main screen should be available: 

 

 

This plot can be accessed by selecting “Edit Test Data (ASCIIprep)” in the 

“ASCIIprep” pull-down menu. 



 

 

 By convention, the injection rates are negative. 

 In the figure above, the green points represent the raw data, called 

“gauge data”. These are the data that are input into PIE either from an 

Excel spreadsheet (Ctrl+C; Ctrl+V) or from a text file (ASCIIprep” menu 

> “Read ASCII-file into Gauge…”) 

 The dark blue points represent the data selected for further analysis, 

called “analysis data”. On the Graphics functions, a button called “Q-

HIST” is used to build the rate data for analysis and a button called 

“SELPRS” to select the pressure data for analysis. 

 Click on the analysis rate to update it. If it does not work, zoom in. 

 Click on the start or the end of a flow period (constant rate period) so 

as to move them towards the time axis. 

 The start and end of each PBU/PFO test should be consistent with the 

rate history. 

 The main keystrokes are: 

 Ctrl – C : Copy data 

 Ctrl-V: Paste data 

 Ctrl-Z: Undo operation 

 Ctrl-Q: Zoom in 

 Ctrl-E: Zoom out 

 Esc: Escape selection 

 Enter: validate selection 

 

 To analyse a well test, select “Period for analysis” in the “Analysis” 

menu.  

 



 

 

 

 

Then double click on the test of interest. 

 

 

Finally, select “Plots” on the top bar menu, then either the “Derivative”, 

“Superposition” or “Data-Plot” plots. 



 

 

 

4.2 Input data into PIE file 

If the time associated with the pressure or rate data is in decimal hours, then a 

reference time needs to be defined. 

 

 

This will set the origin of the elapsed time for the test. The reference time can 

also be input/updated later on, as shown in section 4.2.3 (page 58). 



 

4.2.1 Test-type 

First, the type of test needs to be specified. This can be done by selecting 

“Set Test-Type” in the “Edit” menu. 

 

 

 

As seen in the figure below, different options are available. 

 

 



 

 

 

 For an oil producer or water injector, “Single Phase oil/water” should 

be selected. 

 

 For gas well, it is recommended to select: 

 

o “Gas Test (Pseudo-Pressure)”: With gas being the dominant fluid in 

the reservoir, the diffusivity equation is not linear since the gas 

viscosity, density and total compressibility depends on pressure. If 
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variation is small, these parameters can be assumed constant. As a 

result, the flow equation can be considered linear. 

or 

o “Gas Test (Pseudo-P with Mat. Bal. Correction)”: With significant 

changes in reservoir pressure (depletion or repressurisation), the 

change in gas properties needs to be accounted for with a material 

balance correction.  

 



 

 For a gas condensate well: if the gas is the dominant fluid in the 

reservoir, the single phase gas pseudo-pressure function could be 

used. Any condensate drop out will be treated as a fluid heterogeneity, 

showing a composite behaviour (zone at lower mobility near the 

wellbore).  

 

 Note on multi-phase flow 

Pressure transient analysis is only valid for single phase flow. Any use with 

multi-phase flow would lead to an approximation. PIE proposes different multi-

phase flow analysis methods, but it is not recommended to use them. The 

simplest one is the “Multi-phase (Perrine)”.  

The Perrine approach assumes an equivalent single phase fluid flow in the 

reservoir with constant fluid properties.  By inputting the rates per phase, 

along with a full set of fluid properties, an equivalent single phase fluid rate will 

be calculated at sand-face conditions: (qB)t = qoBo + qwBw + (qg-qoGORs)Bg 

with GORs the solution GOR. 

 

The dimensionless multi-phase pressure is: 
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Any stabilization in the derivative will be indicative of the total mobility: 
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  with k the absolute permeability. 

A phase mobility could be estimated by using only the corresponding phase 

rate in the analysis. 

 

This method assumes that the three phases are uniformly distributed in the 

reservoir, the saturations are independent of pressure and the capillary 

pressure can be neglected.  This is questionable when the saturations are not 

uniform (for example with a gas breakout or liquid dropout in the reservoir) or 

when the fluid cuts at the well are not representative of those in the reservoir. 



 

4.2.2 PVT data 

PVT data can be input by selecting “Edit PVT Data” in the “Edit” menu, as 

shown below. 

 

 

 

 For an oil producer or water injector, some basic input parameters 

are needed to derive the fluid formation volume factor, viscosity and 

compressibility from correlations (Vazquez and Beggs). Otherwise, 

they can also be directly input in the table called “Correlation Results”.  

 



 

 

 

 For a gas well, additional PVT properties are required to calculate the 

pseudo-pressure function. 

 

 



 

 

First the range of pressure values that the PVT data cover needs to be input. 

Estimates of initial pressure and flowing bottom-hole pressure will later be 

entered to evaluate the analysis constants for a specific PBU test.  

 

To do so, select the “Pressure values for table and calcs.” and “ok”. The 

following window will appear. 

 

 

 

 

 

Then there are 3 main methods to input the gas PVT data:  

 

o Entering a PVT table for each parameter (Z-factor, compressibility, 

viscosity) 

 

This can be done by clicking on the parameter, “Enter a property table” and 

“ok”. 

 



 

 

 

 

o Using gas gravity correlations: 

 

This can be done by selecting “Composition, Gravity, and Temperature” and 

clicking on “OK”. The screen below should appear. 

 

 



 

 

 

The gas specific gravity is input, along with the reservoir temperature (and the 

correct unit) and any non-hydrocarbon element (Nitrogen, CO2 and H2S), 

 

Then gas gravity correlations can be set by clicking on each parameter on the 

right, the “Property Correlation by gravity” and “OK”.  

 

 



 

 

 

 

o Using gas composition correlations: 

 

By clicking on “Composition, Gravity, and Temperature” and “OK”, a gas 

composition can be entered in the window below. 

 



 

 

 

Then gas composition correlations can be set in the figure below by clicking 

on each parameter on the right, the “Property Correlation by composition” and 

“OK”.  

 

 

 



 

 

 

 

4.2.3 Static data 

 

The static data can be entered by selecting “Edit Static Data” in the “Edit” 

menu, as shown below. 

 

 



 

 

 

To compute the total compressibility, the user needs to input the initial water 

saturation in percent, and the water and rock compressibility values.  

 

Porosity (in percent in PIE), net reservoir thickness and wellbore drilling radius 

are entered as shown below. 

 

 



 

 

 

 

The second column on the right of the DASTAT window is optional. It can be 

used to convert gauge pressure data to datum depth. Otherwise the analysis 

will be performed at the gauge depth.  

 

For a gas well, the fluid PVT data will be visible once a PBU test is selected 

and the user inputs the flowing pressure at shut-in and an estimate of 

reservoir pressure in the Analysis>Analysis Constants, as shown below.  



 

 

 

 

4.2.4 Input pressure and rate gauge data, one by one 

 

Once the static reservoir parameters and PVT data are input in the PIE file, 

the pressure and rate raw data can be added.  

 

It is recommended to input gauge pressure data at 1 hr interval during flowing 

conditions and <30s interval during PBU tests. Rates could be input hourly if 

measured and daily if allocated. It is recommended to input the entire rate 

history as raw data.  

 

a) Pressure and rate data can be input by reading a text file as shown in the 

figure below. 

 



 

 

 

b) This can also be done by doing a copy (Ctrl+C) of the data from an excel 

spreadsheet and paste (Ctrl+V) into the main PIE screen. 

 

Whatever method is used, PIE will show the following window. 

 

 



 

 

 

 If this is a new well with new data, “Create a new Gauge” should be 

selected.  

 If this is to update a PIE file, “Add to current Gauge” should be 

selected. 

 For data that are formatted into regular columns, “Fixed Columns” 

should be selected. 

 If the data are separated by a delimiter characters (such as comma, a 

pilcrow ¶ or a tab), “Delimited columns” should be used. 

 

In this example, a new gauge is created and “Delimited columns” is used. 

Clicking on “Next>” will lead to the window below. 

 

 



 

 

 

All the available options should not be ticked. 

 

Clicking on “Next>” will lead to this next window: 

 

 

 



 

Since the “Delimited columns” option has been selected, this is where the 

user defines the delimited characters to separate the data into columns. Tab, 

blank or comma could be selected. 

 

If the “Fixed Columns” option is used, then the window will be as follows: 

 

 

 

 

The columns of data need to be defined by clicking on the blank spaces 

between columns. A double click will remove your selection. 

 

The following window shows the columns being defined by the user. 



 

 

 

Clicking on “Next>” will lead to this next window: 

 

 

 

At this stage, the user needs to define the time column and then either the 

rate or pressure column. The rate and pressure data cannot be entered 

simultaneously, but one by one repeating the same steps.  



 

 

The three most common time columns are shown below: 

 

Date-Time Clock-Time Decimal-Hours 
01/10/2019 14:32:15 14:32:15 0 

01/10/2019 14:56:15 14:56:15 0.4 

01/10/2019 15:20:15 15:20:15 0.8 

01/10/2019 15:44:15 15:44:15 1.2 

01/10/2019 16:08:15 16:08:15 1.6 

01/10/2019 16:32:15 16:32:15 2.0 

01/10/2019 16:56:15 16:56:15 2.4 

01/10/2019 17:20:15 17:20:15 2.8 

01/10/2019 17:44:15 17:44:15 3.2 

01/10/2019 18:08:15 18:08:15 3.6 

01/10/2019 18:32:15 18:32:15 4.0 

01/10/2019 18:56:15 18:56:15 4.4 

 

If the user selects “Date-Time”, the seconds should be visible in the time 

column, otherwise this may result in 1-minute pressure data. 

 

To define a particular column, click on the column and then assign a data-type 

from the drop-down list.  

Any wrong attribution will be corrected by selecting the column of interest and 

choosing the “skipped” option from the drop-down list. 

  

In this example, the first column should be defined as “Date-Time” and the 

case indicating the “Date format” should be consistent with the data.  

Thus, if a date with the format dd/mm/yy is entered then the “DMY” date 

format should be used. 

 

First, pressure data will be input by defining the time and pressure columns, 

as shown below. 

 

 



 

 

 

A reference time (“Ref. Time”) will need to be specified in the “Extra settings” 

section if the time column indicates decimal hours. 

 

Clicking on “Next>” will lead to the window below. 

 

 



 

 

 

This is where the user defines the conversion factor for the column data being 

read. In this example, column 2 defines pressure in PSI. So the conversion 

factor is 1. 

 

If the user inputs pressure data in BAR and the pressure unit in the PIE file is 

PSI, then the “BARS” option should be selected from the dropdown list called 

“List of Known Units”. In that case, PIE would multiply column 2 by 14.5. 

 

When clicking on “FINISH”, PIE will import the data. Sometimes the following 

prompt could appear when the software encounters a problem reading a line 

of data. 

 

 



 

 

 

This may indicate a problem with the data.  

 

If the user wants PIE to proceed and continue reading data from the file, click 

“Yes”. The option “Read-to-End” is recommended so that the program will 

continue reading without showing any more prompt.  

 

At the end of the process, the validity of the data needs to be confirmed, as 

shown below. 

 



 

 

At this stage, any error in the unit conversion factor could be easily spotted. If 

so, the additional gauge data will not be confirmed and the process repeated. 

 

c) To input the entire rate data, the same steps are repeated until you reach 

the screen below. Time and rate columns should be defined, and the date 

format & conversion factor checked. 

 

 

 

 

The rate history in PIE is defined as a series of constant rate flow periods. 

Each time value in the history represents the time at which a particular rate 

starts. 

 

At this stage, there is an option in PIE to automatically calculate the analysis-

rate history, as shown in the figure below. This could be a time-efficient option 

with large production times. 



 

 

 

Once the rate and pressure raw data are imported, pressure outliers as 

indicated in the figure below need to be removed.  

 

 

 



 

This can be done with the option “Delete Range of Gauge Data” in the 

“ASCIIprep” menu, as shown below. 

 

 

 

 

 

 

 

 

Then the outliers are selected as shown below. 

 

 

And the range of data to be deleted is confirmed 

by clicking “OK”. 

 



 

  

 

Once the pressure & rate raw data are imported into PIE and outliers are 

removed, the following window will be available.  

 

 

4.2.5 Save the gauge data 

 

It is now time to save this work. To do so, select the “Load/Save/Delete 

Gauge Manager” option in the “ASCIIprep” menu. 

 



 

 

 

The following window will appear. 

 

After naming the current gauge-data and adding an optional descriptive 

comment, click on the current gauge data (top line) and click on the 

“Select/Save Gauge” button. 

 

This work is now saved, as indicated by the window below. 

 



 

 

 

To retrieve these raw data, click on the corresponding previously saved 

gauge-data and then “Select/Save Gauge” button, as shown below. 

 

 

 

 

The final step is to now select the rate and pressure data for analysis. 

 



 

4.3. Select the rate for analysis  

 

4.3.1 Use “Q-HIST” button 

 

First we will build the rate history from the raw data. This is done by clicking 

on the “Q-HIST” button in the figure below. 

 

 

 

 

The following window will appear. 

 



 

 

 

This involves graphic operations to construct the flow periods (constant-rate 

periods). 

 

There are two methods to define a new flow period: 

 

 “Nearest point selected”. By clicking on an existing change in rate or 

pressure, PIE will recognize a start of a new flow period. 

 

 “Maximum gradient change”. The impact of this method can quickly be 

assessed by the user. It involves an algorithm which will detect where a 

change in rates occurs by looking at the pressure data. 

 

The rate value can be estimated by different methods, but the following ones 

are recommended: 

 If the user knows the rate value for a particular flow period (for example 

a rate of 0 for a PBU test), then click on ”Enter a rate value directly”, 

 If the user wants to use the raw rate data (green points) to set the rate 

for analysis, then click on “Calculate rate from rate data”. 



 

 

The “Nearest point selected” method is recommended. Instead of clicking to 

define the start of each flow period, the user could also hold down the left 

mouse button and highlight the time period when the rate is constant.  This is 

shown below. 

 

 

 

Then you can modify directly the rate value and click on ok. 



 

 

 

Once the rate history is built, the user should press “Enter” to validate the 

selection. To undo any action, press “Ctrl+Z”. 

 

4.3.2 Start and End of PBU tests 

 

The rate data should be in agreement with the start and end of each PBU test.  

The example below shows that the start and end of the PBU test are NOT in 

agreement with the rate history. 

 



 

 

 

By clicking on the change in rate with the left mouse button, the start of the 

shut-in period can be shifted towards late time values, as shown below. 

 

 

Left click on the change in rate. A vertical bar named 

“>TO” will appear, indicating the new change in rate. 

 

 

 

 

The new change in rate will be shifted towards later 

time values with a left click. 

Do not hesitate to zoom in the early part of the 

pressure build-up test with “Ctrl-Q”. 

 

 



 

 

Pressing “Enter” will valid your selection, otherwise “Esc” will remove the 

vertical bar. To undo any action, press “Ctrl+Z”. 

 

This process should be repeated for the end of this test and any other PBU 

tests. 

 

4.3.3 Edit the rate of a particular flow period 

 

To edit the rate of a particular flow period, one can simply click on the analysis 

rate with the left mouse button, as shown below. 

 

 

 

 

 

If this option does not appear, the user should probably zoom into the rate of 

interest and repeat the same operation. 

 



 

Once the rate has been updated, pressing “Enter” will valid the selection, 

otherwise “Esc” will cancel the option. To undo any action, press “Ctrl+Z”. 

 

The same process can be done to ensure a rate of 0 for any PBU test. 

 

Once the rate history has been constructed, pressure data can be selected for 

analysis. 

 

 

 

4.4 Select the pressure for analysis  

 

4.4.1 Use “SELPRS” button 

 

The pressure data can be selected for analysis by clicking on the “SELPRS” 

button shown in the figure below. 

 

 

 

 

The following window will appear. 



 

 

 

This window shows different methods to select the analysis pressure data. 

These can be experimented by the user so as to achieve a desired distribution 

of analysis pressure data.  

The “LOG distribution” is recommended with 200 points per flow period. This 

means that 200 pressure points will be distributed on a logarithmic trend per 

flow period. 

 

Once the preferred option has been validated, the pressure data can be 

selected by clicking on the first and last flow periods of interest, or by holding 

down the left mouse button and highlighting the pressure data as shown 

below. 

 



 

 

 

4.4.2 Pick individual pressure points (optional) 

 

The option “Select Individual Points” under the “ASCIIprep” menu below 

allows the user to pick individual pressure points for analysis. 

 

 

 

 



 

4.4.3 Delete analysis pressure data 

 

The pressure data that have been selected for analysis can be deleted with 

the function called “Delete Analysis Pressure Data” under the “ASCIIprep” 

menu. 

 

 

The data to be deleted are highlighted by holding down the left mouse button. 

The selection will need to be confirmed by clicking “OK”. 

 

Bad quality data or pressure data affected by wellbore phase redistribution 

could for example be removed by using this option, so as to perform a 

Deconvolution study. 

 

4.5 Save PIE file 

 

Once the pressure and rate history have been selected for analysis, these 

analysis data need to be saved with the option called “Analysis-Data 

Manager” under the “Edit” menu. 

 



 

 

 

 

The following window will appear. 

 

 

 

After naming the current analysis data and adding an optional descriptive 

comment, click on the current analysis data (top line) and click on the 

“Select/Save Data” button. 



 

 

The analysis pressure and rate data are now saved, as indicated in the 

window below. 

 

 

 

To retrieve these analysis data, click on the previously saved analysis data 

and then “Select/Save Gauge” button, as shown below. 

 

 

 



 

A PIE file is now built and it can be saved by clicking on “Save PIE file” or 

“Save Test As…” under the “File” menu. 

 

The PIE file can now be updated with any new pressure and rate data by 

performing step 4.2.4 to step 4.5. 

 

Now that a PIE file has been created/updated, the process of recovering the 

well and reservoir properties for the different PBU tests can start. Before 

exploring the pressure data, let’s describe the tools that are available to the 

user. 

 


